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​ About this tutorial  

About this tutorial 
"Superelevation" is the banking of a road along a horizontal curve so motorists can safely and comfortably 
maneuver the curve at design speed. As speeds increase and horizontal curves become tighter, a steeper 
superelevation rate is required. 

In this tutorial, you will define a superelevation for an alignment used for a curved road. You will then apply the 
superelevation properties to the road as corridor template instructions. Finally, you will define rollover 
parameters for the road to ensure that slope differences between segments (for example, a driving lane and a 
shoulder in a superelevated curve) are kept to a minimum for safety and comfort at design speed. 

Note: If you do not already know how to work with corridors and specify corridor template instructions, it is 
recommended that you complete the tutorial Working with Corridors before proceeding with this tutorial. 

If you need additional help at any time you are using the software, press F1 to display the online help.  

Step 1. Open the project 
For this tutorial, you will use the project file Working with Superelevations.vce. This project contains a surface, 
a horizontal and vertical alignment, and a corridor. 

Note: The downloaded WorkingwithSuperelevations folder contains this PDF file and the Working with 
Superelevations.vce project file.  

1.​ In TBC, select File > Open. 

2.​ In the Open File dialog, browse to ..\WorkingwithSuperelevations\Working with Superelevations.vce and 
click Open. 

The project opens in the Trimble Business Center window. 

 

The project file is read-only. You can perform the tutorial steps without saving the project file. However, if 
you are interrupted while performing the tutorial, you can save it with a new name by selecting File > Save 
Project As. Then, you can re-open the project to continue the tutorial at a later time. 
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​ Step 2. Apply superelevation to the alignment 

Step 2. Apply superelevation to the alignment 
The horizontal alignment in this project includes two arc curves, one of which includes a spiral in and a spiral 
out. For this tutorial, you will start by applying a superelevation to the two curves to define slope changes 
(banking) through the curve. Later, you will add superelevation instructions to a corridor template. 

Note: For a more detailed description of superelevations, see the "Understanding Superelevations" topic in the 
online help. 

1.​ If the Project Explorer is not already displayed, in the TBC ribbon, select Home > Data > Project Explorer. 

2.​ In the Project Explorer, expand the Alignments node. Then right-click Super Road and select Edit. 

 

The Alignment Editor pane displays in the lower area of the window. 

 

3.​ Select the Superelevation tab in the left side of the Alignment Editor pane. 

If necessary, use the tab scroll control to display the Superelevation tab for selection. 
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​ Step 2. Apply superelevation to the alignment 

The drop down list located at the top of the tab allows you to select each curve in the horizontal alignment 
so that you can define superelevation parameters for it. For each curve, the start station and radius for the 
curve are displayed. 

You will start by defining superelevation parameters for the first curve in the alignment, which is a simple 
arc curve. 

4.​ In the drop-down list, ensure the first curve is selected: 12+00.00, radius = 1000.000. Then enter the 
following parameters: 

a.​ In the Normal cross slope field, ensure the value is -2.00%. 

This value represents the normal cross slope of the road when not in superelevation and is referenced 
by all of the superelevated curves in the alignment. Any changes you make to this field affect all of the 
superelevated curves. If you delete the normal cross slope, the superelevation is removed from the 
alignment. 

Note: The normal cross slope value you enter is used in the Superelevation Diagram view. It does not 
replace the slope value specified in the corridor template instructions. 

b.​ In the Maximum superelevation field, enter 6. 

When you move the cursor to another field or press the Tab key, the value 6 changes to 6.00%. This is 
the maximum rate of superelevation for the curve in terms of percent slope. 

The program automatically enters values for the fields on the right side of the tab based on a maximum 
superelevation of 6.00% and the fact that this is a simple arc curve. Because the arc has no spiral in and 
spiral out, the program uses the arc parameters for the superelevation transitions. This means that 
there is no transitioning from the normal crown to full superelevation, and back to the normal crown. 
The change is abrupt. You will correct this later. 

 

c.​ In the Vertical curve length field, enter 100. 

This value specifies the length of the parabolic vertical curve that will be applied at each beginning or 
ending station transition point in the superelevated curve to smooth the transition. The transition point 
is the PVI (point of vertical intersection) for the vertical curve. The software also draws these vertical 
curves in the superelevation diagram at these transition points. 
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​ Step 2. Apply superelevation to the alignment 

 

You are now ready to define parameters for the second curve in the horizontal alignment, which is an 
arc curve with a spiral in and a spiral out. 

5.​ In the drop-down list, select the second curve: 34+00.00, radius = 900.000. Then, enter the following 
parameters: 

a.​ In the Normal cross slope field, ensure the value is -2.00%. 

b.​ In the Maximum superelevation field, enter 6. 

c.​ In the Vertical curve length field, enter 100. 

The values automatically entered in the fields on the right side of the tab are based on a maximum 
superelevation of 6.00% and the fact that this is an arc curve with a spiral in and spiral out. The 
program uses the spiral in, arc, and spiral out values to fill-in the superelevation transition station 
values. 

 

▪​ Begin superelevation transition specifies the station at which the transition from the normal 
crown to the maximum superelevation of 6% slope begins. 

▪​ Begin maximum superelevation specifies the station at which the maximum superelevation of 6% 
slope begins. 

▪​ End maximum superelevation specifies the station at which the maximum superelevation of 6% 
slope ends and the transition back to the normal crown begins. 

▪​ End superelevation transition specifies the end of the transition from maximum superelevation of 
6% slope back to the normal crown. 

The following figures show the transition from the normal crown to the maximum superelevation, and 
back to the normal crown through a superelevated curve. 

On approach: 
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​ Step 2. Apply superelevation to the alignment 

Start with a normal crown.​

​
Transition to where the outside lane has zero (flat) cross slope.​

 ​
Transition to where the crown has been removed.​

​ 
Maximum superelevation.​

 
On departure: 
Transition back to where the crown has been removed.​

​ 
Transition back to where the outside lane has zero (flat) cross slope.​

​  
Back to normal crown.​

 

You will now take a look at the superelevation you have defined in the Superelevation Diagram view. 

6.​ Click the Superelevation button located at the top of the Superelevation tab. Then, right-click the 
Superelevation Diagram tab and select Move to Previous Tab Group. 

 

 

Working with Superelevations​ 6 



​ Step 2. Apply superelevation to the alignment 

The diagram includes grid lines against which the superelevation profile is displayed. Vertical grid lines 
represent stations in the alignment. Horizontal grid lines represent degrees of slope. The two colored lines, 
which make up the superelevation profile, represent the inside and outside edges of the road. The diagram 
is updated automatically as you make changes on the Superelevation tab. 

Note: You can change the plot scale and vertical exaggeration for the diagram in the Project Settings 
dialog. 

You can see in the diagram that the second curve (2 in the following figure), which is an arc with a spiral in 
and spiral out, includes a transition from the normal crown to the maximum superelevation, and back to 
the normal crown. The first curve (1 in the following figure) does not include spirals, so the program did not 
specify transitions for it. Instead, the curve changes abruptly from normal crown to maximum 
superelevation. You will correct this in the next step. 

 

7.​ In the drop-down list on the Superelevation tab, select the first curve: 12+00.00, radius = 1000.000. Then, 
enter the following parameters: 

a.​ In the Begin superelevation transition field, enter 900. 

b.​ In the End superelevation transition field, enter 2100. 

 

The first curve now shows a transition from the normal crown to maximum superelevation, and back to 
the normal crown. 
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​ Step 2. Apply superelevation to the alignment 

 

You are done applying superelevation to the horizontal alignment. Next, you will add superelevation 
instructions to a corridor template. 
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​ Step 3. Add superelevation instructions to a corridor template 

Step 3. Add superelevation instructions to a 
corridor template 
1.​ In the Project Explorer, expand the Corridors node and the 2 Lane node. Then, right-click 0+000, Typical 

and select Edit. 

 

The Edit Corridor Template pane displays. 

 

The template includes nine instructions that define nodes for Finish and Subgrade material layers. 
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​ Step 3. Add superelevation instructions to a corridor template 

Nodes 2 > EP (1 above) and 5 > EP (2 above), which are the right and left edge-of-pavement nodes for the 
Finish layer, need to be superelevated. Therefore, a Superelevation instruction must be inserted in the 
Instructions list immediately following the two instruction(s) that define these nodes. So, to start, you will 
move the instruction that defines node 5 > EP to directly beneath the instruction that defines node 2 > 
EP. 

2.​ In the Instructions list, click and drag the instruction that defines node 5 > EP to directly beneath the 
instruction that defines node 2 > EP. 
Note that the node name changes from 5 > EP to 3 > EP. 

 

Now you can insert a new Superelevation instruction immediately following the instruction that defines 
node 3 > EP. 

3.​ To insert a Superelevation instruction for the Finish layer, do the following: 

a.​ Select the instruction that defines node 3 > EP in the Instructions list. 

b.​ Click the Add instruction icon located at the top of the Edit Corridor Template pane. 

 

c.​ In the Instruction Type drop-down list, select Superelevation. 

d.​ In the Crown node list, ensure 1 > Super Road is selected. 

e.​ In the Pivot node list, ensure 1 > Super Road is selected. 

This is the node about which the superelevated slope will pivot. This node is automatically added to 
the Selected nodes list. 

f.​ In the Select node drop down list, select 2 > EP and click the Add button to add it to the Selected 
nodes list. 

Optionally, click in the Select node field and then select the 2 > EP node in the template graphic view. 

g.​ In the Select node drop-down list, select 3 > EP and click the Add button to add it to the Selected 
nodes list. 
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​ Step 3. Add superelevation instructions to a corridor template 

 

h.​ In the bottom of the Edit Corridor Template pane, click the Add button. 

The new Superelevation instruction is added to the Instructions list. 

 

4.​ Use the slide control located beneath the Instructions list to view the template along the length of the 
alignment. 

At station 9+00.00 the transition toward maximum superelevation for the first curve begins. Maximum 
superelevation is reached at station 12+00.00. 
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​ Step 3. Add superelevation instructions to a corridor template 

At station 21+00.00, the template returns to the normal crown. At station 25+60.00, the transition toward 
maximum superelevation for the second curve begins. Maximum superelevation for the second curve is 
reached at station 34+00.00. 

 

The Finish grade of the template has been successfully superelevated. Next, you will apply superelevation 
to the Subgrade layer. 

5.​ To insert a Superelevation instruction for the Subgrade layer, do the following: 

a.​ In the Instructions list, double-click the last instruction in the list (the instruction that defines node 10 
> SG-ES). 

b.​ Click the Add instruction icon located at the top of the Edit Corridor Template pane. 

c.​ In the Instruction Type drop-down list, select Superelevation. 

d.​ In the Crown node list, select 8 > SG-CL. 

e.​ In the Pivot node list, select 8 > SG-CL. 

This node is automatically added to the Selected nodes list. 

f.​ In the Select node drop down list, select 9 > SG-ES and click the Add button to add it to the Selected 
nodes list. 

g.​ In the Select node drop down list, select 10 > SG-ES and click the Add button. 

h.​ In the Selected nodes list, right-click 1 > Super Road and select Delete to remove it from the list. 
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​ Step 3. Add superelevation instructions to a corridor template 

 

i.​ In the bottom of the Edit Corridor Template pane, click the Add button. 

The new Superelevation instruction is added to the Instructions list. 

 

6.​ Use the slide control located beneath the Instructions list to view the template along the length of the 
alignment. 

Note that the superelevated slope of the Subgrade layer now matches that of the Finish layer. 

 

You are now ready to define rollover parameters for the road to ensure that slope differences between the 
driving lanes and shoulders in the superelevated curves are kept to a minimum for safety and comfort at design 
speed. For more information on rollover parameters, see "Rollover Parameter Examples" in the online help. 
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​ Step 4. Define rollover parameters 

Step 4. Define rollover parameters 
As shown in the following figure, when the road is at maximum superelevation in the first curve, there is a 10% 
slope difference between the left lane (the outside lane in the curve) and the left shoulder. There is a 2% slope 
difference between the right lane (the inside lane in the curve) and the right shoulder. 

 

Key:​
1. -4% shoulder​
2. 10% delta​
3. 6% super left lane​
4. -6% super right lane​
5. 2% delta​
6. -4% shoulder 

Both of these slope differences are too extreme for the design speed. So, you will specify a maximum and 
minimum delta that applies to the corridor that will change these slope differences. You will start by defining 
the maximum and minimum allowable slope differences for the right drive lane and shoulder. 

1.​ In the Instructions list, double-click the instruction that defines the node 4 > ES. Or, right-click the 
instruction and select Edit. 

This node defines the right shoulder. The properties for the instruction are displayed in edit mode. 

 

2.​ Click the Define rollover parameters check box. 
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​ Step 4. Define rollover parameters 

The Maximum delta value specifies the allowable maximum slope difference between the driving lane and 
the shoulder on the outside of a curve. The Minimum delta value specifies the minimum slope difference 
between the driving lane and the shoulder on the inside of the curve. Note that for this road, the right lane 
is the inside lane in the first curve, and the outside lane in the second curve. So the Maximum delta value 
will apply to the right lane and shoulder in the second curve. The Minimum delta value will apply to the 
right lane and shoulder in the first curve. 

3.​ In the Maximum delta field, enter 4%. In the Minimum delta field, enter 0%. Then click the Save button. 

4.​ Use the slide control located beneath the Instructions list to view the template along the length of the 
alignment. 

Note that when you reach maximum superelevation for the first curve, the difference between the right 
(inside) lane and the right shoulder is now 0%, based on the 0% Minimum delta you specified. 

 

When you reach maximum superelevation for the second curve, the difference between the right (outside) 
lane and the right shoulder is now 4%, based on the 4% Maximum delta you specified. 

 

You are now ready to define the rollover parameters for the left lane and shoulder. For this road, the left 
lane is the outside lane in the first curve, and the inside lane in the second curve. 

5.​ In the Instructions list, double-click the instruction that defines the node 6 > ES. Or, right-click the 
instruction and select Edit. 

 

6.​ Click the Define rollover parameters checkbox. 

7.​ In the Maximum delta field enter 4%. In the Minimum delta field, enter 0%. Then click the Save button. 

8.​ Use the slide control located beneath the Instructions list to view the template along the length of the 
alignment to view the rollover parameters. 
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Step 5. View the alignment in 3D Drive View 

Step 5. View the alignment in 3D Drive View 
To see a simulation of a drive along the newly superelevated roadway, follow these steps: 

1.​ In the Project Explorer, expand the Alignments node. Then right-click Super Road and select New 3D Drive 
View. 

 

 

2.​ Use the slide control located along the bottom of the tab to view the roadway along the length of the 
alignment. 

 

Note that you can also use the Speed control and Start button to automatically drive through the view. 

This completes the tutorial. 

Working with Superelevations​ 16 


	About this tutorial 
	Step 1. Open the project 
	Step 2. Apply superelevation to the alignment 
	 
	Step 3. Add superelevation instructions to a corridor template 
	Step 4. Define rollover parameters 
	Step 5. View the alignment in 3D Drive View 

